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How to Use the Visual3D™ Tutorials 
 

There are four tutorials, covering: 
(1) Building a Model 
(2) Data Visualization 
(3) The Command Processing Pipeline 
(4) Signal and Event Processing 
(5) Analysis and Reporting. 

 
Each tutorial starts where the previous one ends. The results of each tutorial are 
automatically saved as a .cmo file. So you can skip parts or try different features. 
 
To locate sample input files 
 
All the sample input files you will need for this tutorial can be downloaded from the C-
Motion website: 
 
 http://www.c-motion.com/support/tutorials.htm 

 
Objectives of Tutorial #2 

 
This tutorial assumes that Visual3D has been installed and that a model has been 
created as described in Tutorial #1. 
 
Tutorial #2 has three objectives: 
 
1. exploring the content of the C3D data files; 
2. assigning a .c3d movement data file to a model; 
3. description of force platform parameters. 
 
The file “Tutorial2.cmo” contains the results of this tutorial.   
 
You need at least two input files to perform an analysis: a standing calibration file of 
the subject and a movement trial These files must be saved in .c3d format for use with 
this program. Most motion capture systems can save data in this form. Otherwise, use 
C-Motion’s file converters (Check our website for details). 
 

Preparing for Tutorial #2 
 
1. Create the sample model ‘model sample.cmo’ in Tuturial #1 OR download the 
finished version from the C-Motion website: 
 

http://www.c-motion.com/support/tutorials.htm 
 
2. Download the movement trial file: ‘Walking Trial 1.c3d’.  
 
3. Save the file where you would normally save motion capture files. 
 
NOTE: The activities in this tutorial will not alter the data in these files. Visual3D 
copies the data into the workspace. Even in the workspace, the original data is 
maintained for recalculation purposes. 
 

Loading the Files 
 
1. Open an empty Visual3D workspace.  
 
2. Open the model from Tutorial #1. From the File  O p l e
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The workspace status screen will show the model with no corresponding motion file. 
 

 
 
3. From the File menu, select Open, and select the downloaded file ‘Walking Trial 
1.c3d’.  
 
4. Select “Add the new files to your currently open files” and click OK. 
 

 
 

Associating Movement Trials and Model Files 
 
Visual3D saves the ‘Walking Trial 1’ file in the Motion Files column, but not directly 
beside the static trial file.  
 
1. Click on the Signal and Event Processing Tab. The viewing area will open. 
 
At this point, the file has not be associated (or mapped) to the model. In the viewing 
area, only the markers will be animated. 
 
NOTE: If no image appears, verify that the filename “Walking Trail 1.c3d” appears in 
the file name box, instead of ALL FILES. To activate the animation, click on the 
arrowhead PLAY button at the bottom of the screen. The marker figure should walk 
across the screen. However, no 3D form will appear. 
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2. In the Model menu, select Assign Model to Motion Files. A dialog box will open. 
Select the ‘Lower body Static Trial.c3d’ file and the ‘Walking Trial 1.c3d’ file, and click 
OK.  
 

 
 
NOTE: For multiple selections, hold down the CTRL key while you select files. 
 
The 3D Animation Viewer should now display a skeleton of the lower body that has 
been associated with your movement data. You can animate the skeleton by selecting 
the PLAY button. 
 
NOTE: If you do not see the skeletal structure, click on the View Segments icon. If 
you still do not see the skeleton the directory containing the animation models may 
not be set correctly. Check the paths near the bottom left of the Workspace Tab. 
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The 3D Animation Viewer 
 
Once you have assigned a motion file to a model, Visual3D creates a new folder 
(KINETIC_KINEMATIC) in the Data Tree of Signal and Events Processing mode. This 
folder contains basic kinematic and kinetic data for the trial. This information is 
actually intermediate data and the user should create “Model Based Data” rather than 
analyze this data (see Tutorial5). For more information on the types of FOLDERS and 
their contents, please see the online reference documentation. 
 

 
 
Simple errors in the labeling of markers in the data files may become apparent at this 
stage. For example, the missing right foot segment in the above figure. In this 
example, the RFT1 marker was accidentally labeled RFT1A when the marker was 
identified in the data collection program. These types of errors can be corrected in 
Visual3D. 
 
To rename a marker label 
 
1. Click on the TARGET folder to open the inner folders. Then click on the ORIGINAL 
folder. This will open the original data file.  
 
2. Right-click on RFT1A (the erroneous marker label) to open an options box. 
 
3. Select Rename Label and enter a new target (RFT1). You can add a description as 
well (optional). Click OK. 
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4. The data file has now been corrected. However, the Workspace has not been 
updated so the segment will not appear. Select the RECALC button on the toolbar, or 
switch to Model Builder mode and select Build Model. 
 
The 3D figure will now have the missing foot. 
 

 
 
 
To export a corrected c3d file (optional) 
 
1. In the File menu, select Export C3D File. 
 

 
2. A dialog box will open. Select “Walking Trial 1.c3d”.  
 
3. Select the filename to be exported. It is permissible to overwrite the existing file. 
 
4. Leave all other options at the default values. Many of these options are available to 
handle quirks in the c3d file format, and should only be used when necessary. 
 
5. Select Export. 
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Changing Views 
 
You can reset the camera perspective to lock onto a segment and keep it centered on 
the screen. You may want to stop the animation before proceeding. 
 
To focus on one segment 
 
1. Right-click a segment of the 3D figure to select that segment (e.g., SLK). A list of 
segment options will open. 
 
2. Select Track Segment Center of Mass with Camera. An animation will open 
which keeps the selected segment centered on the screen. 
 

 
 
3. De-select this option before continuing: Right-click on the segment, then remove 
the checkmark. 
 
Note: That the camera orientation relative to the segment can be modified. Under the 
View Menu select Set Camera Perspective. Orient the camera looking at the 
Laboratory Origin (e.g. at the x.y.z axes that are drawn); this will orient the camera 
relative to the laboratory. Select Save Current Segment Perspective. Now you can 
select Move Camera to Track Segment and the camera orientation will follow the 
selected segment rather than the laboratory orign. 
 
Animation Controls (pan, zoom, tilt) options 
 
The camera orientation is controlled using the mouse. This was described in Tutorial 1, 
but here is a summary. 
 
Hold the mouse button down as you move the mouse across the viewing area. 
 

Left mouse button: rotation 
Right mouse button (or scroll): zoom 
Middle (or both) buttons: translate 
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Exploring Your Data 
 
Data exploration is a key aspect of attempting to ensure that the original data has 
been recorded correctly.  
 
To create a QuickView of Data 
 
You can use a QuickView Signal Graph to display targets or analog data. You can use 
Quickview to help plan for interpolating missing data or using low- or high-pass filters 
to eliminate excessive noise from signals. From the Quickview screen, you can also 
export a single signal file to an ASCII file. 
 
1. Click on the TARGET file to open the inner files, and then click on ORIGINAL to 
open the original data. Click (left click) on the desired file (e.g., RTF1). 
 
2. Select the Signal Quickview tab to view analog graphs. A Quickview can help you 
to locate obviously incorrect or noisy data. 
 
3. Select Signal Data to see raw data or to export to an ASCII file.  
 

 
 
Close the graph by clicking on the X in the top right-hand corner of the graph. 
 
To display a signal graph 
 
Signal graphs (different from signal data graphs in QuickView) are interactive and 
offer different viewing options of the data. Signal graphs appear on the right-side of 
the screen and can be used to visualize or add event labels.  
 
1. Right-click the target file in the ORIGINAL file (e.g., RTF1).  
 
2. Select Graph X, Y and Z, and select New Graph. A set of graphs will open on the 
right side of the screen. 
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NOTE: Use the Add to Existing option to add new signals to an existing graph. 
 

 
 
3. Place the mouse on any point of the line on any graph and click. This will display 
information about that point (or event). 
 
To format and animate a signal graph 
 
1. In the View menu, click on View Graph Animation Frame Line. This will create a 
line on the graph to correspond to a point in an animation. Then click PLAY in the VCR 
control panel to activate the animation. The vertical line on the signal graph will move 
along with the 3D figure. 
 
2. In the View menu, try these other viewing options: View Lab, View Trail of 
Segment/Target Paths, View GRF Butterfly, and View White Background. 
 

 
3. To format the signal graph, right-click anywhere on the graph to open an options 
menu. Select Format Graph. Enter your desired changes and click Apply. 
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Force Platform Data 
  
Force Platforms provide critical data for biomechanical analysis because they measure 
the interaction between the subject and the environment. If the subject is in contact 
with the floor, the joint forces, moments and powers have no physical meaning unless 
the reaction force data are included in the analysis. 
 
NOTE: The Analog signals that are collected from the force platform are NOT 
the force signals. The force signals must be computed from these Analog signals 
using several parameters that specify the type of computations required (different 
force platforms require different computations). For information about force platforms, 
see the c3d file format manual stored at www.c3d.org or the Visual3D online 
reference documents. 
 
To create graphs of a force plate signal 
 
1. If the graph area at the right is still occupied, right-click anywhere on the graph 
area and select Remove all graphs.  
 
2. In the Data Tree, select the ANALOG folder, then ORIGINAL. Right-click FZ1, 
select Graph Z, and New Graph. This will open a graph of the Fz ANALOG channel of 
force platform1 
 
3. In the Data Tree select the GRFORCE folder, FP1, Z-component, and New Graph. 
This will open a graph of Z-component of the Ground Reaction Force signal. 
 
Note that the two signals are related to each other, but they are not identical. The 
ANALOG signal is stored in the coordinate system of the force platform. The GRFORCE 
signal is stored in the Laboratory (Motion Capture) Coordinate System. 
 

ANALOG SIGNAL

GRFORCE SIGNAL

 
 
NOTE: We often get questions from users claiming that the ANALOG signals 
for the force platform exist, but the GRFORCE signal is zero. Check to see that 
the Fz Channel of the ANALOG signals is negative. If not, then the ANALOG 
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scale factor in the C3D file has probably been stored incorrectly by the motion 
capture software. The scale factor will need to be changed; see later section. 
 

Modifying the Force Platform Parameters in the C3D File 
 
Force Platform data are perhaps the most confusing aspects of the C3D file format. All 
of the required Force Platform parameters for the type of Force Platform must be 
defined correctly. Some of the parameters are specified by the Force Platform 
manufacturer; these values are provided in the Manufacturers User Manual. Note that 
some of these parameters can not be transferred directly in the C3D file.  
 
The C3D format assumes consistency between units throughout the file. If the Motion 
Capture data has been collected in millimeters, ALL distance measures in the file must 
be consistent. This means that the corner locations, and Force Platform ORIGIN values 
must be in millimeters, and the moment channels of the force platform must be 
expressed in Newton-millimeters. 
 
To examine or modify the parameters. 
 
1. In the File menu, select Modify Force Platform Parameters.  
 

 
 
2. Click on the Get Current C3D Parameters button to populate the dialog box.  
 
The Force Platform Zero Baseline Interval indicates that the first 10 frames of 
data will be averaged to define a baseline, which is then subtracted from every frame 
of data.. 
 
The ORIGIN (mm) shows a –21 mm Z component. The manufacturer manual will 
show a positive z-component. The c3d format assumes that this value will be a vector 
from the ORIGIN to the center of the top surface of the platform in the force platform 
coordinate system, which means that the value in the C3D file should be negative. 
 
Corner 1, Corner 2, Corner 3 and Corner 4 are the locations of the force platform 
corners specified in the laboratory coordinate system. This information is used to 
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transform the signals from the force platform coordinate system to the laboratory 
coordinate system. In principle the force platform can be located in any orientation in 
the 3D data collection volume; e.g. the force platform does not have to be on the 
floor.. 
 
The Analog Channels column shows the analog channel assignment number in the 
order the ANALOG channels appear in the c3d file. 
 
3. Click Done or Cancel when finished examining data. 
 

Thresholding the force platform signals in Visual3D 
 
When force platform data exists, Visual3D attempts to assign the signal to a segment 
that comes into contact with it. If there is a low level of background noise in the 
signal, it will appear that something must be in contact with the force platform at all 
times. To ensure that only “sensible/real” contacts are used, a threshold values is 
specified such that any ground reaction force signal below this value is assumed to be 
zero. This ensures clean contacts with the force platform.  
 
1. Select the Properties menu.  
 
2. Click on the Modify Minimum Force Platform Value. A dialog box will open to 
allow you to set a higher (or lower) threshold than the default.  
 

 
 
3. You can also choose one of the other options for modifying force platforms. Select 
Modify FP Center of Pressure Distance to Segment to specify a minimum distance 
(.2m default). This option allows you to verify that a particular signal has been caused 
by a segment.  
 
 
********************** 

You have now successfully completed Tutorial 2. Save the Workspace as “Tutorial2.cmo”. Tutorial 3 will 
show you the Command Processing Pipeline.  

 


